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Preface

Preface

This Installation Guide introduces SafeSync and guides you through planning the
installation and installing SafeSync.

Topics in this chapter include:
s SafeSync Documentation on page v
s Audience on page v

*  Document Conventions on page vi

» Terminology on page vii




Preface

SafeSync Documentation

SafeSync documentation includes the following:

TaBLE 1. SafeSync Documentation

DOCUMENTATION DESCRIPTION

Installation Guide | A PDF document that discusses requirements and procedures for
installing SafeSync.

Administrator’s A PDF document that discusses getting started information and

Guide SafeSync usage and management.

Help Hosted HTML files that provide "how to's", usage advice, and field-
specific information. The Help is accessible from the SafeSync web
console.

Readme file Contains a list of known issues and basic installation steps. It may

also contain late-breaking product information not found in the Help
or printed documentation

Knowledge Base | An online database of problem-solving and troubleshooting
information. It provides the latest information about known product
issues. To access the Knowledge Base, go to the following website:

http://esupport.trendmicro.com

Download the latest version of the PDF documents and readme at:

http://docs.trendmicro.com

Audience

SafeSync documentation is intended for administrators responsible for SafeSync
management, including SafeSync installation and management. These administrators are
expected to have advanced networking and server management knowledge.



http://esupport.trendmicro.com
http://docs.trendmicro.com
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Document Conventions

The documentation uses the following conventions.

TABLE 2. Document Conventions

CONVENTION DESCRIPTION

UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs,
and options

Italics References to other documents

Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Configuration notes

Note

Q Tip Recommendations or suggestions
Important Informatlon regardlng're.qu[red or default configuration
settings and product limitations

Critical actions and configuration options

9 WARNING!
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Terminology

The following table provides the official terminology used throughout the SafeSync
documentation:

TaBLE 3. SafeSync Terminology

TERMINOLOGY DESCRIPTION

Administrator (or SafeSync | The person managing the SafeSync server
administrator)

Console The user interface for configuring and managing
SafeSync.

The console for the SafeSync server program is called
"web console".

End-user Users that share content using SafeSync.







Chapter 1

Preparing for Installation

This chapter introduces SafeSync, deployment recommendations, and system
requirements.

This chapter includes the following topics:
s About SafeSync on page 1-2
« Deploying SafeSync on page 1-3

»  System Requirements on page 1-4
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About SafeSync

Trend Micro SafeSync is a turnkey solution for the Enterprise to the Cloud. SafeSync
provides a seamless data accessing experience to users in a more secure, flexible and
convenient way.

+  Integrated with most external storage types (SAN or NAS).
+  Single sign-on support for Active Directory and LDAP.

+  Secure your data in the cloud at any time. SafeSync supports file version control
and redundant backups of your data.

. Access your data using various devices (PC, Mac, Android, iOS devices)

«  Enhance teamwork using a shared collaborative data space.

Why Use SafeSync

SafeSync provides the following:

BENEFIT DESCRIPTION

Access Anytime, anywhere file accessing, editing, and organizing from
any device: PCs, Macs, and Android, and iOS mobile devices.

Sync Data storage and synchronization with additional file copies
held on your on-premise servers that can be easily restored or
accessed, in case of a hardware loss, theft, or failure.

Continuous automatic file synchronization with 2 ways to
synchronize files. End-users can drag and drop files — Easily
into the folder they wish to sync.

Folder pairing enables automatic syncing of an entire folder
without the need to drag and drop into the SafeSync folder.
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BENEFIT

DESCRIPTION

Share

Fast and secure file and folder sharing with the shareable link.

Set links with passwords that expire for additional security.

“Team Folders” for effective group collaboration that can be
created on the fly by staff and administrators.

Multiple-user accounts

SafeSync supports centralized administration for creating and
controlling users.

Recover

Recovery of deleted files or previous file versions allows you to
turn back time.

Confidentiality

You operate the data center, so no third party has access to
your data.

Encryption

Data is transferred between you and SafeSync using the same
AES 256-bit encryption used by financial institutions.

Centralized remote
administration

You have the ability to control user accounts and share or
revoke access to your shared files at any time.

Security

SafeSync has a built-in firewall that stops network traffic that is
not required for sharing files.

Load balancers

Installing two SafeSync appliances ensures constant
availability of online backup and file restoration, even in the
event of equipment failure.

Redundant server and
Internet connections

Two copies of data are stored on two separate servers plus two
separate service providers connecting the data center ensuring
availability of data.

Deploying SafeSync

SafeSync can be installed in a single appliance deployment or as a set of paired

appliances. When deploying as a set of paired appliances, the first appliance (primary
server) is the parent appliance. The other appliance (secondary server) is the failover
appliance.
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System Requirements

The following table provides the system requirements for using SafeSync.

TaBLE 1-1. System Requirements

HARDWARE/SOFTWARE DESCRIPTION
Network switch 1GB
CPU 64-bit x86 (dual-core recommended)
Memory 4GB (32GB recommended)
Network card Two 1GB NIC
System disk space 60GB (for SafeSync installation)
Storage disk space The disk storage depends on the needs of the users in
the network.

Tip
Q Trend Micro recommends allocating 8 to 10GB to
each user. If you want to replicate all of users’
files, the allocated space is doubled (16-20GB).
For example, if you intent to have 100 users, the

recommended storage space is 2TB.




Chapter 2

Installing SafeSync on Bare Metal
Servers

Install one SafeSync and shared data is backed up on storage devices the administrator
specifies. However, if the appliance encounters any issues end-users will not be able to
access their shared data.

v
Trend Micro recommends installing two SafeSync appliances for high availability of
SafeSync for end-users.

This chapter has the following topics:
« Installing a SafeSync Appliance on page 2-2

« Installing SafeSync Appliances for High Availability on page 2-3
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Installing a SafeSync Appliance

Any existing data or partitions are removed during the installation process. Back up any
existing data on the system (if any) before installing SafeSync.

Procedure

1.  On a Bare Metal server, insert the installation DVD into the DVD drive of the
desired server.

2. Power on the Bare Metal server.
A prompt appears with information about installing SafeSync.
3. Click OK.
The License Agreement screen appears.
4.  Sclect Agree and Install to agree to the license agreement.
The Select Installation Type screen appears.

5. Select Primary server to install a single server or to install the first server in a high
availability deployment.

6. Click OK.
The Confirm Web Console Settings screen displays.

7.  Sclect one of the following to determine the connection settings for the end-user
and management web consoles:

+  Select yes to use the default connection settings.
+  Select no to modify the connection settings.

Once installation completes the Log On screen for the command line interface
appears.

8. Using a web browser, log on to the web management console (<SafeSync domain
name>: 3443) with the following user name and password:

. user name: administrator
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+  password: safesync

Installing SafeSync Appliances for High
Availability

Any existing data or partitions are removed during the installation process. Back up any
existing data on the server before installing SafeSync.

Procedure

1. Install the first SafeSync appliance. See Installing a SafeSync Appliance on page 2-2 for
instructions.

2. On asecond Bare Metal server, insert the installation DVD into the DVD drive of
the desired server.

3. Power on the Bare Metal server.
A prompt appears with information about installing SafeSync.
4. Click OK.
The License Agreement screen appears.
5.  Seclect Agree and Install to agree to the license agreement.
The Select Installation Type screen appears.

6.  Sclect Secondary server to install the second server in a high availability
deployment.

7. Click OK.
The Confirm Web Console Settings screen displays.

8.  Select one of the following to determine the connection settings for the end-user
and management web consoles:

«  Select yes to use the default connection settings.
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+  Select no to modify the connection settings.

Once installation completes the Log On screen for the command line interface
appears.

9. Using a web browser, log on to the web management console (<SafeSync domain
name>: 3443) with the following user name and password:

. user name: administrator

. password: safesync
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Installing on VMware ESXi

When installing SafeSyncon a VMware ESXi, the virtual machine requires the following:

SYSTEM

Minimum REQUIREMENT

Virtual machine

VMware ESXi™ 4.x, 5.x

CPU 64-bit single core
RAM 4GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Launch VMware ESXi.

2.  Select File > New > Virtual Machine from the menu.
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The Create New Virtual Machine screen appears.

@ Create New Virtual Machine

ESRECRE X

Configuration
Select the configuration for the virtual machine

Virtual Machine Version: 8

ration .
gur
Mame and Location = .
0
Storage Typical
Guest Operating System Create a new virtual machine with the most common devices and configuration options.
Network
Create a Disk " Custom
ReaHly W coplet? Create a virtual machine with additional devices or spedific configuration options.

__tep |

< Back | Mext > I Cancel

Ficure 3-1. Select Configuration

3. Seclect Typical.

4. Click Next.

=
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The Name and Location screen appears.

(&) Create New Virtual Machine

Name and Location

Virtual Machine Version: 8
Specify @ name and location for this virtual machine

Confiquration

Name and Location
Storage

Guest Operating System
Network

Create a Disk

Ready to Complete

MName:

Safesync for Enterprise

Virtual machine (VM) names may contain up to 80 characters and they must be unique within each

vCenter Server WM folder.

VM folders are not viewable when connected directly to a host. To view VM folders and specify a location

faor this VM, connect to the vCenter Server.

e |

< Back | Mext = I

)

Ficure 3-2. Name New Virtual Machine

5. Type a name for the virtual machine.

6. Click Next.




SafeSync for Enterprise Installation Guide

The Guest Operating System screen appears.

(&) Create New Virtual Machine : @ﬂn

Guest Operating System irtual Machine Version: 8
Specify the guest operating system to use with this virtual machine

Configuration

Name and Location GAESLUDETding Sets
Storage T Windows

Guest Operating System =

Network £ tinux

Create a Disk & Other

Ready to Complete

Identifying the guest operating system here allows the wizard to provide the appropriate defaults for
the operating system installation.

Help | < Back | Mext = Cancel

Ficure 3-3. Guest Operating System
7.  Select Other and choose Other (64-bit) from the drop-down.

8. Click Next.
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The Network screen appears.

(&) Create New Virtusl Machine == X

Hetwork
Which network connections will be used by the virtual machine?

Virtual Machine Version: 8

Configuration

— Create Network Connections

Mame and Location
Storage How many MICs do you want to connect? m
Guest Operating System
Network (,:;:r:;‘:(cg:t
Create a Disk Adapter
Ready to Complete

! * E1000 - ¥

MNIC 2: [private Netwark | [E1000 B

@ If supparted by this virtual machine version, more than 4 NICs can be added after the
virtual machine is created, via its Edit Settings dialog.

Adapter choice can affect both networking performance and migration compatibility. Consult
the VMware KnowledgeBasefor moreinformation on choosing among the network adapters
supportedfor various guestoperating systemsand hosts.

LI <Back | Next> | Concel

A |
Ficure 3-4. Create Network Connections
9. Select 2 NICs and specify the following settings:
TaBLE 3-1. Network Settings for SafeSync
Name NETWORK ADAPTOR CoNnNEcT AT Power ON

NIC 1 VM Network E1000 Enabled

NIC 2 Private Network E1000 Enabled
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10. Click Next.

The Create a Disk screen appears.

—
(&) Create New Virtual Machine o

Create a Disk Virtual Machine Version: 8
Spedify the virtual disk size and provisioning palicy

Confiquration Datastore: Idaiz:skirel
Mame and Location
Storage

Available space (G8): [ e
Guest Operating System =

Metwark - =

e Virtual disk size: I 3

Create a Disk i il
Ready i Compiete % Thidk Provision Lazy Zeroed

" Thick Provision Eager Zeroed
£ Thin Provision

Help | < Back | Next > Cancel
- )
Ficure 3-5. Create Disk Settings

11.  Select at least 60GB of virtual disk space for SafeSync.
12. Sclect Thick Provision Lazy Zeroed.

13. Click Next.
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The Ready to Complete screen appears.

@ Create Mew Virtual Machine
Ready to Complete Virtual Machine Version: 3
Click Finish to start a task that will create the new virtual machine
Configuration ) Settings for the new virtual machine:
:7;"1& B Lacalics Name: New Virtual Machine
rage :
ook O aivie Sy Host/Cluster: localhost.client.tw.trendnetorg
Netwark Datastore: datastorel
Create a Disk Guest05: Other (§4-bit)
Ready to Complete NICs: 2
NIC 1 Network: VM Netwaork
NIC 1 Type: E1000
NIC 2 Network: Private Network
NIC 2 Type: E1000
Disk provisioning: Thick Provision Lazy Zeroed
Virtual DiskSize: 60 GB
[ &t e virbual machine setings before completion |
R ———— el
/4 Creation of the virtual machine (VM) does not indude automatic installation of the guest operating
system. Install a guest OS5 on the YM after creating the VM.
Help | < Back | Continue Cancel
— — 4

.

Ficure 3-6. Ready to Complete

14.  Sclect Edit the virtual machine settings before completion.

15.  Verify the settings for the new virtual machine and then click Continue.
The Virtual Machine Properties screen appears.

16. Open the Hardware tab and select Memory (adding).
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Memory Configuration appears in the right pane.

(&) Mew Virtual Machine - Virtual Machine Properties

Hardware | Options | Resources |

™ show All Devices

Add... | Remove |

Hardware

CPUs (adding)

Video card (adding)

VMCI device (adding)

New CD/DVD (adding)
New Floppy (adding)

New SCSI Controller (add...
New NIC (adding)

New NIC (adding)

New Hard Disk (adding)

1880kEP0IDO

Summary

2

Video card
Restricted
Client Device
Client Device

LSI Logic Parallel
VM Network
Private Network
Virtual Disk

—Memory Configuration

101 GBI Memory Size: | a=] [es~]

512 GEH
256 GB H
128 GEH
64 GBEH

32 GEH

16 GE—d

& GE H

4GB
ZGE
1GE
512 MB
256 MB
128 MB
64 MB
32 MB
16 ME
& MB

4 MB

<

Maximum recommended for this
guest OS: 1011 GB.

Maximum recommended for best
performance: 16264 MB.

Default recommended for this
guest O5: 512 MB.

Minimum recommended for this
guest OS: 64 MB.

_ v |

Ficure 3-7. VM Properties - Memory Configuration

17. In the Memory Size ficld, select at least 4GB.

18. From the Hardware tab, select CPU (adding).

CPU settings appear in the right pane.
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@"'New\"n'tual Machine - \frlual Mﬁd’une Properties

Hardware |Dphons|R.esoumes|

| T Show All Devices | Remave | Number of virtual sockets: -

[Hardware | Summary Number of cores per socket: 2 -]
B Memory (adding) 2048 MB
[ CPUs (adding) 2 | Total number of cores: 2
Video card (addi Video card
E Vﬂadgme(rdf:m\ —_— Ay g;aﬂwﬂﬁmmld‘rb?m;tewmal[?;;aﬂﬂmemt
25 New CD/DVD (adding) dlient Device msltszti A
& New Floppy (adding) Client Device
@ New 5CSIController (add...  LSI Logic Parallel The virtual CPU configuration specified on this page
BB New NIC (adding) VM Network might violate the license of the guest 05,
BB New NIC (adding) Private Network
& New Hard Disk (adding) Virtual Disk

Ficure 3-8. VM Properties - CPU Settings
19. In the Number of virtual sockets field, select 1.
20. In the Number of cores per socket field, select 2.

21. Click Finish.
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Installing on a VMware Workstation

When installing SafeSyncon a VMware Workstation, the virtual machine requires the

following:

SYSTEM

Minimum REQUIREMENT

Virtual machine

VMware® WorkStation™ 6.x, 7.x or above

CPU 64-bit single core
RAM 4GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Launch a VMware WorkStation.

2.  Select File > New > Virtual Machine from the menu.
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A setup wizard appears.

[T MSHE ; X New Virtual Machine Wizard
Welcome to the New Virtual Machine Wizard
What type of configuration do you want?

Virtual Machine Configuration
() Typical (recommended)

Create a Workstation 6.5-7.x virtual machine in a few easy steps.

@ Custom (advanced)

Create a virtual machine with advanced options: change the SCSI
controller and virtual disk type, specify compatibility with older
VMware products, etc.

VMware

Workstation 7.1

(Kowi] o [EE]

Ficure 4-1. Virtual Machine Configuration

A

3. Seclect Custom (advanced).

4. Click Next.
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The Virtual Machine Hardware Compatibility screen appears.

P |x| New Virtual Machine Wizard

Choose the Virtual Machine Hardware Compatibility
‘Which hardware features are needed for this virtual machine?

Virtual Machine Hardware Compatibility

Hardware compatibility: ESX Server Compatible

Workstation 6 Limitations:

Workstation 5 32 GB memory limit
Workstation 4 8 processor limit

Fusion 2x 10 network adapter limit
Fusion 3.x 2 TB disk size limit
Server 2.x

Workstation 6.5
Workstation 7.x

VMware

Workstation 7.1

lxgmcellléﬁackllipﬂextl

Ficure 4-2. Virtual Machine Hardware Compatibility screen
5.  Seclect Workstation 6.5-7.x from the drop down list.

6. Click Next.
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The Guest Operating System Installation screen appears.

1800 [\ New Virtual Machine Wizard

Guest Operating System Installation
A virtual machine is like a physical computer; it needs an operating system. How will you ﬁ

install the guest operating system?

Install operating system from:

() Installer disc:

(@ Installer disc image file (ISD):

l |~ Browse.. ]

J’roothesktopfSafeSyncForEnterpr'ise-Z.l}-]|

Ubuntu 64-bit Server 10.04.4 detected.
This operating system will use Easy Install. (What's this?)
) Twill install the operating system later.
The virtual machine will be created with a blank hard dislk

VMware®

Workstation 7.1

l xgnncell[ éﬂnckll 5> Next 1

&

Ficure 4-3. Guest Operating System Installation screen
7.  Sclect one of the following:
. Select Installer disc:, if a DVD is mounted to the physical machine.

+  Sclect Installer disc image files (ISO): to upload the iso file from a
physical machine.

VMware detects the operating system from the DVD or ISO files.

8. Click Next.
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The Easy Install Information screen appears.

8.00. - Xl bew iyl Machine Wizard
Easy Install Information
This is used to install Ubuntu 64-bit.

Personalize Linux

Full name: [ safesync

User name: [ safesync

Password:

-

Confirm:

l
l
l

ViMware
Workstation 7.1

lxgancellléﬁacklliﬁﬂextl

&

Ficure 4-4. Easy Install Information screen
9.  Provide the user name and password for Ubuntu.

10. Click Next.




SafeSync for Enterprise Installation Guide

The Name the Virtual Machine screen appears.

800 (X New Virtual Machine Wizard
Name the Virtual Machine
What name would you like to use for this virtual machine?

Virtual Machine Name

Name: [SafeSyncForEnterpr‘ise l

Location: [a’m0ta"vmware.n’SafeSyncForEnterprise l

The default location can be changed at Edit > Preferences.

VMware®

Workstation 7.1

I % Cancel H ¢ Back H % Next |

4

Ficure 4-5. Name the Virtual Machine screen
11.  Type a name for the virtual machine.
12. Type a path for file storage.
13. Click Next.
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The Processor Configuration screen appears.

WBi00 ; X New Virtual Machine Wizard
Processor Configuration
Specify the number of processors for this virtual machine.

Processors

Number of processors:

Number of cores per processor:

Total processor cores: 1

VMware

Workstation 7.1

1p l xga.ncel ll 4= Back ll &> Next 1

&

bt

Ficure 4-6. Processor Configuration screen

14. Provide the number of processors and the number of cores for the processors that
the virtual machine uses.

15. Click Next.
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The Memory for the Virtual Machine screen appears.

800

[X| New Virtual Machine Wizard

Memory for the Virtual Machine

How much memory would you like to use for this virtual machine?

Memory

32GB
16 GB
8GB
4GB
2GB
1GB
512 MB
256 MB
128 MB
64 MB
32 MB
16 MB
8 MB

4 MB

VMware®

Workstation 7.1

< Maximum recommended memory
(Memory swapping may occur beyond this size)
7068 MB

4 [E] Recommended memory

d 512 MB

D Guest OS5 recommended minimum
256 MB

l & cancel l l <@ Back l l &> Next

Ficure 4-7. Memory for the Virtual Machine screen

16. Specify at least 4GB RAM for SafeSync.

17. Click Next.

2

Specify the amount of memory allocated to this virtual machine. The
memory size must be a multiple of 4 MB.

Memory for this virtual machine: E MB
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The Network Type screen appears.

[T Mg : [X| New Virtual Machine Wizard
Network Type
What type of network do you want to add?

Network Connection

() Use bridged networking

Give the guest operating m direct acce o an external
Ethernet network. The guest must have its own IP address on the
external network

@ Use network address translation (NAT)

Give the guest operating system access to the host computer's dial-
up or external Ethernet network connection using the host's IP
address.

() Use host-only networking

Connect the guest operating s
on the host computer.

stem to a povate virtual network

) Do not use a network connection

VMware

Workstation 7.1

(X cow | [ pox | [ 1o |

7]

Ficure 4-8. Network Type screen
18. Select Use network address translation (NAT).

19. Click Next.
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The Select I/O Controller Types scteen appears.

800 || New Virtual Machine Wi
Select I/0 Controller Types
‘Which SC5I controller type would you like to use?

I/0 Controller Types
IDE controller: ATAPI
SCSI controller: ) Fusloon
@ LSI Logic (Recommended)

) LSI Logic 8AS

BusLogic S5CSI controllers are not supported on 64-bit virtual
machines.

VMware®

Workstation 7.1

l xgancelll Qiﬁackll &> Next l

A

Ficure 4-9. Select I/0 Controller Types screen
20. Select LSI Logic (Recommended).
21. Click Next.
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The Select a Disk Type screen appeats.

800, : x| New Virtual Machine Wizard

Select a Disk
Which disk do you want to use?

Disk

@ Create a new virtual disk

A virtual machine is composed of one or more files on the host file
system, which will appear as a single hard disk to the guest
operating system. Virtual disks can easily be copied or moved on
the same host or between hosts.

1 Use an existing virtual disk
Choose this option to reuse a previously configured disk.

(JUsea Ehymcal disk (for advanced users)

: this option to give the virtual machine direct ace
local hard dislk.

VMware

Workstation 7.1

(X coneet | [ & moox | [ Bow |

“

Ficure 4-10. Select a Disk screen
22. Select Create a new virtual disk.

23. Click Next.
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The Select a Disk Type screen appeats.

800, . [N] New Virtual Machine Wizard
Select a Disk Type
What kind of disk do you want to create?

Virtual Disk Type

IDE

@ SCSI (Recommended)

Mode
[ ] Independent
Independent disks are not affected by snapshots.
O Persistent
Changes are immediately and permanently written to dislk
@ Nonpersistent

Changes to this disk are discarded when
you power off or re e a snapshot.

VMware

Workstation 7.1

(W [ | [ ]

A

Ficure 4-11. Select a Disk Type screen
24. Select SCSI (Recommended).

25. Click Next.
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The Specify Disk Capacity screen appears.

800 X/ New Virtual Machine Wizard
Specify Disk Capacity
How large do you want this disk to be?
Disk Size

Maximum disk size (in GB): [0 [Z]

Recommended size for Ubuntu 64-bit: 20 GB

|| Allocate all disk space now

Allocating the full capacity can enhance performance but requires
all of the physical disk e to be available right now: If you do not
allocate all the space w, the virtual disk starts small and grows

as you add data to it

() Store virtual disk as a single file
(@ Split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to
another computer but may reduce performance with very large
disks.

VMware®

Workstation 7.1

l xancel ll <= Back ll &> Next l

i

Ficure 4-12. Specify Disk Capacity screen
26. Specify at least 60GB of disk space for SafeSync.
27. Click Next.
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The Specify Disk File screen appears.

800 [\| New Virtual Machine Wizard
Specify Disk File
Where would you like to store the disk file?

Disk File

One disk file will be created for each 2 GB of virtual disk capacity. File
names for each file beyond the first will be automatically generated
using the file name provided here as a basis.

File name: |SafeSyncForEnterprise.vmdk l

VMware

Workstation 7.1

l 3 Cancel ll <2 Back ll &> Next l

&

Ficure 4-13. Specify Disk File screen
28. Specify where to store the disk file.

29. Click Next.
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The Ready to Create Virtual Machine screen appears.

800, . (x| New Virtual Machine Wizard
Ready to Create Virtual Machine
Click Finish to create the virtual machine and start installing Ubuntu 64-bit and then ﬁ
VMware Tools.

The virtual machine will be created with the following settings:

Name: SafeSyncForEnterprise
Location: Jroot/vmware/SafeSyncForEnterprise
Version: Workstation 6.5-7.x

Operating System: Ubuntu 64-bit

Hard Disk: 60 GB
Memory: 4096 MB
Network Adapter: NAT

Other Devices: CD/DVD, Floppy, USB Controller, Printer, Sound
Card

[ Customize Hardware...

[ Automatically power on this virtual machine after creation.

VMware

Workstation 7.1

[ & Cancel l [ 4= Back l l @ Finish

Ficure 4-14. Ready to Create Virtual Machine screen

30. Click Customize Hardware.
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The Hardware screen appears.

Hardware
Device | Summary DIECE Ry
= Memory 4096 MB Specify the amount of memory allocated to this virtual
o machine. The memory size must be a multiple of 4 MB.
£ Processors 1 B
(5 New CD/DVD (IDE) Using file /root/Desktop/y  Memory for this virtual machine: ﬂ LI
[ Floppy Auto detect 32GB
% Network Adapter NAT 16 GB
USE Controller Present 8GB
H 4 Maximum recommended memory
& Sound Card Auto detect 4 GB = (Memory swapping may occur beyond this size)
= Printer Present 2 GB EiHRIH
= Display Auto detect 1GB
512 MB
J Recommended memory
256 MB d 512 MB
128 MB
654 MB
32 MB ] Guest 0S recommended minimum
256 MB
fi [ 1 I
8 MB
| & add. || = s A ME

Ficure 4-15. Hardware screen

31. Click Add.
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The Hardware Type screen appears.

W8.0.0 : [X.Add Hardverg Wizard,
Hardware Type Q
What type of hardware do you want to install?

This wizard will guide you through the steps of adding new
hardware to your virtual machine.

To begin, please select the type of hardware you want to add.

CD/DVD Drive
[=l Floppy Drive

H USB Controller Maximum limit reached

& Sound Card Maximum limit reached
L2} Parallel Port

(@) Serial Port

& Printer Maximum limit reached

VMware
@ Generic SCSI Device

Workstation 7.1

[ % Cancel ] [ Back ] [ % MNext |

]

32. Seclect Network Adapter.
33. Click Next.
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The Network Adapter Type screen appears.

800, I\ Add Hardware Wizard
Network Adapter Type Q
What type of network adapter do you want to add?

Network Connection
() Bridged: Connected directly to the physical network
[ Replicate physical network connection state
® NAT: Used to share the host's [P address
() Host-only: A private network shared with the host

() Custom: Specific virtual network

/devivmnet0

Device Status

Connect at power on
U

Workstation 7.1

[xgancelllégack”qumh

Ficure 4-16. Network Adapter Type screen
34. Select NAT.
35. Select Connect at power on.

36. Click Save.
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The Hardware screen appears.

Hardware
Memory 4096 MB
4§ Processors 1
(%) New CD/DVD (IDE) Using file /root/Desktop!
[ Floppy Auto detect

% Network Adapter NAT
{il USB Controller Present

& Sound Card Auto detect
= Printer Present
[ Display Auto detect

% Network Adapter 2 NAT

i [ D)

ErraEerTn

Memory

Specify the amount of memory allocated to this virtual
machine. The memory size must be a multiple of 4 MB.

Memory for this virtual machine: MB

32 GB
16 GB
8GB
4GB
2GB
1GB
012 MB
256 MB
128 MB
64 MB
32 MB
16 MB
8 MB
4 MB

a Maximum recommended memory
(Memory swapping may occur beyond this size)
7068 MB

<

Recommended memory
d 512 MB

['] Guest 0S recommended minimum
256 MB

FiGure 4-17. Hardware screen

37. Click Save.

[ 8 Cancel I [ E Save }
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The Ready to Create Virtual Machine screen appears.

800, . (x| New Virtual Machine Wizard
Ready to Create Virtual Machine
Click Finish to create the virtual machine and start installing Ubuntu 64-bit and then ﬁ
VMware Tools.

The virtual machine will be created with the following settings:

Name: SafeSyncForEnterprise
Location: Jroot/vmware/SafeSyncForEnterprise
Version: Workstation 6.5-7.x

Operating System: Ubuntu 64-bit

Hard Disk: 60 GB
Memory: 4096 MB
Network Adapter: NAT

Other Devices: CD/DVD, Floppy, USB Controller, Printer, Sound
Card

[ Customize Hardware...

[ Automatically power on this virtual machine after creation.

VMware

Workstation 7.1

[ & Cancel l [ 4= Back l l @ Finish

Ficure 4-18. Ready to Create Virtual Machine.

38. Click Finish.
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When installing SafeSyncon an Oracle VM VirtualBox, the virtual machine requires the

following:

SYSTEM

MiNIMuM REQUIREMENT

Virtual machine

Oracle VM VirtualBox™ 4.x

CPU 64-bit single core
RAM 4GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Log on to the Oracle VM VirtualBox.

2.  Click the New button on the toolbar to add a new virtual machine.

3. Click Next.

The VM Name and OS Type screen appeats.
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@ Orad i
File Machine Help

D& 0

(5 Do) (@ Sspstots 13
New Setings St Diverd
050215 _appliancel (Snapshot 2) ) Gonoral i
Povernd Oif
r‘ @ Neme: 051514 _testing2
[88) 1 050215_appliance2 S Type: Ubuwntu (54 bit)
|71 @rovemaon B syeem
&)~ 051514_sppliancel BaseMemory: BIGHE _—
S el . 051514 testing?

Aoecleration: ¥T-AMD-7, Nestd Paging
@] 051514_appliance?
A @rownin =)

[B) ] 051514 _testing? (Snapshot 1) Create New hi
/| @Fowered Off G _os—

VM Name and OS Type

Enter a name for the new virtoal machine and seleetth type of the guest opersting system you plan o instll oo the
vistual machine.

- b i et
VirtualBox components to identify your virtual machine.
Name | a8 00GE)
appliance] ‘
[
08 Type
Operting Sysem: [Lie B
Version: (Dbuatu (64 bif) -] =
|/ ok Connection)
| a
—

Shared Folders
HNone

@ Description
Hone

4. Provide a name for the virtual machine.
5. Sclect the following for the OS Type:

. Linux

«  Ubuntu(64-bit)
6. Click Next.

The Memory screen appears.
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File Machine Help

@ @ '% @ (5 Debis| (@ smapshors (13

New Settings Strt Discarl

= 052;15,%13“&1 (Snapshot 2) 5| General [ Preview
r @ e Neme: 051514 _testing2

050215_appliance2 O Type: Ubuntn (64 bit)

(ZA @rovemion B syeem
(81 051514_appliancel BaseMemory: 896MB Y <ting?
st A O1514.testing?

Aoceloration: VT-/AMD-Y, Nested Paging

6} 51514_appliance2
|71 @rovemaon ¥ Create New Virtual Machins

[ 031514 _testing? (Swapshot 1)
|71 @rover ot

Memory

Select the amount of base memory (RAM) in megsbytes o be allocated 1 the virtusl machine
The recommended base memory size is 192 ME.
Bese Memory Size

0 “anos m
ol || a8 00GB)
96 MB

4MB

xk Conagetion)

Shared Folders
HNone

@ Deseription
None

7.  Specify the amount of memory allocated to the virtual machine.

Tip

Trend Micro recommends specifying at least 4GB of memory.

8. Click Next.

The Virtual Hard Disk screen appears.
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el
File Machine Help

D& 0

(5 Debis| (@ smapshors (13
New Seffings Strt Disarl

050215_appliance] (Snapshot 2) General Preview
@Pousna Oif a B

Wene: 051514 testing2
050215_appliance2 O Type: Ubuntn (64 bit)
|71 @rovemaon Syotom
[~ 051514 _appliancel BaseMemory: BIGHE _—
Lot apn: B D v R, ot i 051514 _testing?

Aoceloration: VT-/AMD-Y, Nested Paging

051514 _appliance2
@oventott

[E] 051514_testing? (Smpshot 1) Create E‘:!
[ @roverd ot .

Virtual Hard Disk

f you wish yor can 10w sdd s shriup disk o the new machine. You can eiter create & new virtual disk or select one
$x00m the st or from nather loeation vsing the folier icon.

I you need s more complex vistual disk setup you ean skip this step and make the changes o the machine seings once

e mashine i et

The meomended sze of he st tp 0k 8.00 OB, | Bt 006E)
Strtup Disk
® Crote new hard disk i

©) Use existing hard disk

[© 050215 _spplinncel vl o, £.00 GE) @

| frork Connection)

Shared Folders
HNone

@ Description
Hone

9.  Select Start-up Disk.
10. Select Create new hard disk.
11. Click Next.

The Welcome to the virtual disk creation screen appears.
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File Machine Help

D& 0

New Settings Strt Discarl

(G5 Deib | (@ Snapahots 1)

[¢4)~| 050215_appliancel (Snapshot 2) General Preview
(27 @rovenort A &

Neme: 051514 _testing2
050215 _ay S Type: Ubuwntu (54 bit)

(aR Jeetra sy
[~ 051514_appliancel Bz 051514_testing?
@Poversd O _testing
2 51514 _appliance2 Create firtual Disk
97 g © il ™
G 051514_testing2 Svpihot ) Welcome to the virtual disk creation wizard
[ @roverd ot

This wigard vill help you to create & new vistol disk for your virtusl machize.

Uss the Next bution 1o 20 t the next page of the wizaxd and the Back button 10 rstum 1 the previous pags. You can alio
press Cancel if you want 1 cancel ths execution of this wiz

Fleas choose the type of b that you would ke 1 s for the new virtualdisk 1f you do not need to us it with oher I
vistualzaton softvere yor oo save tisselng mnchanged.
b type
@ VDI (VirtoalBox Disk Image) | 0GE)
(© VMDK (Virtual Machine Disk)
©) VED (Vi Hawd Disk) i

©) HDD (Parsllels Hord Disk)

o) e ] |

Shared Folders
tone

@ Deseription
None

12.  Specify the type of the virtual disk to use.

Tip

If you do not use the virtual machine with other virtualization software, leave the
setting as VDI (VirtualBox Disk Image).

13. Click Next.

The Virtual disk storage details screen appears.
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@ @ > & (G Deie] @ Smapshors 1)

Nev Seings Sart Disart
[¢4),~| 050215 _appliancel (Snapshot 2)
(7] @voveniont

5 General [ Preview
Name: 051514 _esting?
05 Type: Ubuntn (64 bit

Sysem

050215_appliance2
@Povent ot

51514 _appliancel
@rower Off

[88)~1 051514 _appliance2
Orowent o

[ 031514 _testing? (Swapshot 1)
|77 @roverd ot

051514_testing2

Virtual disk storage details
Please chaose whether the new virtel dik file should be allacated as it vsed or f it shovld be created fully allocated.

4 dynamically allocated virtusl disk fle vill oy vsz spacs on your physivel hard sk a it fills w, alfhovgh it will ot
shiink again anfomatically when spce on it s freed.

A fixed size virtual disk il may teke Ionger o creste on orme systens bt is often st 1 e
Storage detodls

® Dynamieally allocated

© Fied size

Shared Folders
HNone

@ Description
HNone

14.  Specify whether disk space if allocated dynamically or if disk space is fixed.

Note

Dynamically allocated space is allocated as the space fills up.

Fixed disk space only takes as much space as you allocate, but the fixed size disk is
often faster to use.

15. Click Next.

The Virtual disk file location and size screen appears.
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VM VirtuaiBox |

e Mastine-—ticy

ORI @ St
Wov Sibgs Ser Dt

(8851 050215 1 (Snapshot 2)
SromrB el F

&

[@)~] 051514_appliancel
|77 @roverd Ot

[88)~1 051514 _appliance2
Orowent o

[ 051514 _testing? (Suspshot 1)
|77 @roverd ot

5 General

Neme: 051514 testing?
O Type: Ubuntu (54 bit)

Sysem

[ Preview

050215_appliance2
@Povent ot

051514_testing2

Virtual disk file location and size

Please type the name of the boox below or click. ©
create the £le .

Location.

spplisacel|

Selet the size of the virtual disk in megabyes. This size villbe reportd 1 the Gruest OS s the maximurn siz of this virtoal
disk.

Size

= [
o [ AN S0
400MB

Shared Folders
HNone

@ Description
HNone

16. Specify a name and location for the virtual disk.

17. Specify the size of the virtual disk.

Tip

Trend Micro recommends specifying more than 60GB.

18. Click Next.

The Summary screen appears.
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sl
File Machine Help

@ @ > & (G Deie] @ Smapshors 1)

New Settings Strt Discarl

5 General [ Preview

Neme: 051514 testing?
O Type: Ubuntu (54 bit)

Sysem

[¢4),~| 050215 _appliancel (Snapshot 2)
(7] @voveniont

050215_appliance2
@Povent ot

051514_testing2

51514 _appliancel
@rower Off

[88)~1 051514 _appliance2
Orowent o

[ 031514 _testing? (Swapshot 1)
|77 @roverd ot

Summary

You s going 1 create & new virtual disk with the following perameters:

Fibtyge, YDIictlBosDinags)
Benth. Drmicabalocatones o
Location: C\Userstjoe _tsad\W irtual BoxVM stapplisnce] tapplisncel vdi

e

If the above settings are comect, press the Creae button, Once yow press it the new virtval disk file will be created.

Shared Folders
HNone

@ Description

o

19. Review the specifications for the virtual machine.

20. Click Create if the specifications are correct.

The virtual machine appears in the virtual machine list.
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(3 Debis) @ Smapshots

050215_appliance2
@Povent ot

051514_sppliancel
@rower Off

51514_appliance2
@oventott

051514_testing? (Snapshot 1)
@Fowerd Off

Configure t

5| General 5] Preview
asne:spplisacel
05 Type: Ubuntu (64 bit

Sysem
BaseMemory: 1024MB

Bootoxier. Floypy, CDIDVD-ROM, Hord Disk
Hecertion: TTA4MD-T, Nesed Paging

appliancel

Display

VideoMemory:

RemgteDeskiopServer: Disabled.

@ Storage

IDEContoller

IDESecond arybaster(CD/DVD): Empty
84 ThController

54 TAPortD: appliancel.vdi (Noxmsl,8 D0GE)
P tutio

HostDriver: Windows DirectSound

Controls, 1CH ACST

& Network

Adagte: Lnel PROJLDO0 MT Deskiop (NAT)

£ usB

DeviceFilles: 1 (0 ective)
Shared Folders
Hone

@ Description
HNoae

21. Select the new virtual appliance.

22. Click Settings from the main menu to set up the environment for SafeSync.

The Settings screen for the virtual machine appears.
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23.

24.

25.

26.

59 Oracle VM VirtualBox Manager =

Ele Machine Help

@& O (58] @ s

New Settings Strt Discarl

(8 050215_appliance] (Snapshot 2) Genexal Preview
s o B O]
OS Type: Ubuntn (54 bif)

[83,~] 050215_appliance2
@Povent ot

Sysem

051514_appliancel iory: 1024MB appliancel
/| @Fowered Off Floppy, CDDYD ard Disk DD/ C
0515144 {Z} appliancel - Settings i
Powersd Off
lragc) = General ‘Sﬁonxe ‘
& ting? (S @ system
4] 051514 _testing2 (Snapshot 1) Syt Somen Toe P =
|57 @roverd ot -
= e @ IDE Controller CDVDYD Drive: (IDE Seoontary Mastr _ ~
[ i orage =
'&wm; ot l : :a % @ Empty [7] Live CDIDYD Choose avirtual CD/DVD disk file...
udio -
A SATA Contoller Information. Host Drive 'E:
i :ﬂw‘opyk . applncet i Tswe - VirtualAppliance-051514.iso
erial Ports -
2 use Location: — (@ Remove disk from virtual drive
_ Atiached To:
Shared Folders
[l =K Xel
Setecta =
et move informaton

None

Click Storage from the Settings screen.
The content for Storage appears.
Select IDE Controller.

Right-click the CD/DVD drop down list and select
SafeSyncForEnterprise-2.0.iso.

Click Network from the Settings screen.

The content for Network appears.

Note
;

SafeSync uses Adapter 1 network settings.

The SafeSync database uses Adapter 2 network settings.




Installing on an Oracle VM VirtualBox

5% Oracle VM VirtualBox
Ele Machine Help

D& 0

(3 Debis) @ Smapshots
New Seffings Strt Disarl

[¢4)~| 050215_appliancel (Snapshot 2)
(7] @vovenitnt

[~ 050215 _appliance?
(27 @roventon

[~ 051514_appliancel
ﬁf‘: @Foverd Off

5| General 5] Preview
asne:spplisacel
05 Type: Ubuntu (64 bit

Sysem
BaseMemory: 1024MB

appliancel

{Z} appliancel - Settings

%uugpphmxz

Powersd Off

- & General ‘ Network

| 051514_testing? (Snapshot 1) System

W‘: @Povered Off Dipley Adeptor ! | Adapr2 | Adopr3 | Adapierd a
B Displ

- © sorage 9] Enabl Network Adaptes
& Network Nane: LA ithemet Adaptr #2 -
B Serial Ports D Advanced | Lnternal Network
2 us
Shared Folders

[ o the Host O, I

I

27. Specify one of the following for Adapter 1:

+  Bridge Adapter: Select this option to allow connection to SafeSync using
public networks.

+  Host-only adapter: Sclect this option to only allow local access to SafeSync.

28. Click Adapter 2.

The Adapter 2 tab displays.
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Ele Machine Help

@ @ e < (CiDeets) @ Smpshots

New Settings Strt Discarl

(64 050215_appliance] (Snapshot 2)
(27 @rovenort

5| General 5] Preview

ame:  applisnce1
O Type: Ubuntu (54 bit)

050215_appliance?

(@ Powered Ot =
[@)] 051514_appliancel BaseMemory: 1024ME appliancel
|57 @roverd Ot

[3,~] 051514 _appliance2
(AR =t

[ Network

4]~ 051514 _testing? (Suspshot 1)

|57 @roverd ot

Adegter? | Adupter3 | Adapierd

— © storsge Ensble Netvork Adapter
Broveaon LI P JE. =
& Network Name: intne| A
B serolPorts b hdvanced
2 use

Shared Folders

Euterthe e o the inecnal netvork hat his metvork scd will b concted o, You oancrats aney | | |
et

‘machine or others

29. Specify Internal Network for Adapter 2.




Chapter 6

SafeSync Post-Installation Tasks

This section outlines recommended and optional post installation tasks for SafeSync.

This chapter has the following topics:

Mounting Additional Disks on page 6-2




SafeSync for Enterprise Installation Guide

Mounting Additional Disks

SafeSync automatically mounts only one disk by default. Additional disks need to be
manually mounted to SafeSync.

The example below assumes that SafeSync is deployed as a set of paired appliances, and
the primary server already has one disk installed. This example describes how to add a
new disk to the primary server.

Note

You have to do these steps only if you want to use more than one disk.

Procedure

1. Log on to SafeSync.

2. Obtain the root permission:
sudo -1i

3. Specify the root password.

4.  Format the disk before mounting it to SafeSync:
This example uses sdb as the name of the new disk.
dmesg | grep sdb
fdisk /dev/sdb

5. Mount the disk:
mkfs.ext3 /dev/sdbl
mkdir /storage/mogdata/devl12
mount /dev/sdbl -t ext3 /storage/mogdata/devl2

6. Add the disk to the mogile system:

chown www-data:mogstored /storage/mogdata/devl2
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chmod g+w /storage/mogdata/devl2

mogadm —--trackers=trackerl:6001 device add osdp-storel 12
--status=alive

Save the settings:
vi /etc/fstab

/dev/sdbl /storage/mogdata/devll ext3
defaults,user xattr, netdev 1 2







Chapter 7

Verifying Installation

After installing SafeSync, Trend Micro recommends testing the installation.

Procedure

1.

Open the SafeSync web console using the following address: https://
www.example.com/

Note

The actual address may vary according to your DNS settings.

Log on into the SafeSync web console using the default account credentials:
+  User name: administrator

. Password: safesync

Click Upload Files to upload files to SafeSync.

The Upload Files screen appears.

Select the files you want to upload and click Add Files.

Select at least one photo to upload.

Click Start Upload.
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The files you select upload to SafeSync.

) IREND. | SafeSync for enterprise

‘administrator (adminsirator) - Sign out

] 0 (e 9] i

[P Account information

@] View this photo 2 5150d83aru1_s1500_sa280._was uploaded f tisfolder

£ Defauit TeamFolder Org

(51 Download this photo 18 Tip: Install SafeSync to have changes to the . Download Now 14D Using 24.33 GB of 1501 GB
View details
< Getlinktothis photo . Pe—
iame ypo Last Modied 8 Seats usna: 280050
Previous versions EroeE
o () 2 Backup File Foider 210812012 15:38. §? Customization
[ Editon your computer = ‘Support Details.
X Delete this photo

7 Rename this photo
3 Move or copy this photo

P [ 16258
[/ Backup. [ sep2012

@ (g Team Folders

1@ Recycl Bin

5150dB3arvl_s1500_aa280_
JPEGIFIF Image

Note

The photos you upload to SafeSync, display as a thumbnail in the content area.

)TREND. | SafeSyNC for Enterprise

‘administrator (agministrator) - Sign out

Y & = E e D) o Ussaries

e

() View images and videos | +/ StSodarv| s500_sa280_was uploaded fo s ocer.
() Download thisfoicer | @ Tip:

< ShowLinks

Download Now

£ Default TeamFolder Org

@ Using 2433 GB of 1501 GB

View detalls

o T (38 Sent s 8 o150
4 Customization
— B
& [y Files
1) Backup.
28 Toam Folders
13 Recycke Bin

Select the files that were just uploaded and click Download the selected items.

A dialog box appears.

Specify where to download the selected files and click OK.

The selected files download to the location you specify.

Select a photo you uploaded and click View this photo.

The photo appears in its original size.
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® - O SafeSync- thumbnail.aspx - Mozilla Firefox

{} appliance.com appliance.com

Share your files by selecting a file and clicking Get link to this file.

SafeSync creates a shareable link to that file. People you send that link are able to
access the files by clicking the link.
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Share this photo

SafeSync provides security for any link you share. For additional
protection, use any or all of the options below. Move your mouse
cursor over an option to learn more about it.

Shareable link | https:/ fwww.example.com/KgC/09-10

B@E0rn=a

Enable Extra Protection

menrd| |

Link expires on | |

Single-use link [




Chapter 8

Contacting Technical Support

Trend Micro provides technical support, pattern downloads, and program updates for
one year to all registered users, after which you must purchase renewal maintenance. If
you need help or just have a question, please feel free to contact us. We also welcome
your comments.

«  Getallist of the worldwide support offices at bzzp:/ [ esupport.trendmicro.com
. Get the latest Trend Micro product documentation at h##p:/ / does.trendpaicro.com

In the United States, you can reach the Trend Micro representatives through phone, fax,
or email:

Trend Micro, Inc.

10101 North De Anza Blvd.,

Cupertino, CA 95014

Toll free: +1 (800) 228-5651 (sales)
Voice: +1 (408) 257-1500 (main)

Fax: +1 (408) 257-2003

Web address: http://www.trendmicro.com
Email: support@trendmicro.com



http://esupport.trendmicro.com
http://docs.trendmicro.com
http://www.trendmicro.com
mailto:%20support@trendmicro.com
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